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1 Introduction 
 
This installation guide describes the requirements and setup procedures for running ODMS R8 
in a virtual environment using Windows Terminal Service, Citrix XenApp/ XenDesktop, and 
VMware Horizon view platforms. ODMS R8 is available for use in a virtual environment with 
Windows Terminal Service. 
 
ODMS R8 usually installs the Dictation Module/Transcription Module and Device Customization 
Program on the Guest PC, but if you want to use it in a virtual environment, you can install 
them on a Windows Server or virtual OS. However, if you want to use ODMS R8 in a virtual 
environment, you can also use it in a virtual environment by installing the Dictation 
Module/Transcription Module and accessing from a Guest PC. 
 
Depending on the virtual environment used, the OM Client Virtual Driver is required for the 
Guest PC. 
In addition, since the software is used by multiple users, it must be installed with the ODMS R8 
Multi-user License corresponding to the number of users. 
The ODMS R8 Multi-user License must be obtained from your Dealer/Distributor. 
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2 System Overview 
 
ODMS R8 usually installs the Dictation Module/Transcription Module/Device Customization 
Program on the Guest PC, but if you want to use it in a virtual environment, install the 
Dictation Module/Transcription Module/Device Customization Program on a Windows Server or 
virtual OS. However, when using in a virtual environment, it is possible to install the Dictation 
Module /Transcription Module on a Windows Server or virtual OS and access it from a Guest PC 
to use it in a virtual environment as well. 
 
On the Guest PC, install Remote Login Client software to support client connection to the 
network and virtual access to applications, or “Remote Desktop Connection”, “Citrix Workspace 
App, VMware Horizon Client” or other client apps must be enabled. 
 
In some virtual environments, ODMS R8 requires the “OM Client Virtual Driver” to be installed 
on the Guest PC to support network communications and to support connected OM Digital 
Solution devices and audio-related functions. 
 
 

 
 
In addition, since the software is used by multiple users, it must be installed with the ODMS R8 
Multi-user License corresponding to the number of users. 
The ODMS R8 Multi-user License must be obtained from your Dealer/Distributor. 
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2.1 System Requirement 
The following table shows the operating conditions for ODMS R8 in a virtual environment. 
 

Item Condition 
Client OS - Windows 10 / 11  

  Windows 10 or Windows 11 based Thin Client PC 
CPU 2 GHz or higher 

*Not supported single core processor 
Memory 2 GB or more (Windows 10) 

4 GB or more (Windows 11) 
Network 100 Mbit/s or faster transfer rate, TCP/IP network protocol 
Display 1024 x 768-pixel resolution or higher 

65,536 colors or more (16.77 million colors or more recommended) 
Graphics DirectX 9 compliant graphics device with WDDM 1.0 or higher driver 
USB With the Dictation Module and Transcription Module: 

One or more USB ports available 
Sound With the Dictation Module and Transcription Module: 

A Microsoft WDM- or MME-compliant and Windows-compatible sound device 
Virtual Environments 
  
(ODMS software 
running on server OS) 

Virtualization Software: (Supported on the server operating system) 
- Remote Desktop Service (Windows Terminal Service), Remote App 
- Citrix XenApp 7 – 7.2402  
- Citrix XenDesktop 7 – 7.2402  
- VMware Horizon 7 – 8.2312 
- Azure Virtual Desktop 

 
Virtual Desktop Operating System: 

- Windows 10 / 11 
- Windows Server 2016 / 2019 / 2022 

Client Operating System: 
- Windows 10 / 11 
NOTE: 
- Using Citrix virtual environments requires a separate Citrix user 
license. 
- Using Remote Desktop Service or Remote App requires a separate 
 RDS CAL license. 
- Remote connections via Microsoft Store apps are not supported. 
- Using VMware View requires a separate VMware View user license. 
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2.2 Support Devices 
ODMS R8 supports remote connection of the following OM Digital Solutions devices. 
When a device is connected to the Guest PC in a virtual environment, the application installed 
at the remote location can detect, operate, and configure the device. 
 

DVR DS-9500, DS-9100, DS-9000 
DS-2700, DS-2600 

RecMic RM-4010N/4110N 
RM-4000P/4010P/4015P/4100S/4110S 

Foot Switch RS27N/28N/31N 
RS27H/28H/31H 
    (Set to Olympus mode) 
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2.3 ODMS App for Virtual Host PC 
ODMS R8 applications that can be used in a host PC (or Virtual Host PC) environment are as 
follows. 
 

 Dictation Module (requires ODMS R8 DM Multi-license) 
 Transcription Module (requires ODMS R8 TM Multi License) 
 Device Customization Program (No license is required) 
 
Note: ODTD (OM Downloader Tool for DPM) is not supported. 

 
When used in a virtual environment, each Multi-license for ODMS R8 is required. 
Please contact your Dealer/Distributor to obtain the Multi-license. 
Also, please refer to the Installation Guide for ODMS R8 Standalone Launcher for information 
on installing each application. 
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2.4 ODMS App for Guest PC 
ODMS R8 applications to be installed on the Guest PC are as follows 
OM Client Virtual Driver is required only when the Host PC is a server OS such as Terminal 
Service, XenApp, etc. It is not required when the Host PC is a Desktop OS such as Windows 
10/11. 
 
The OM Client Virtual Driver supports communication between OM Digital Solutions devices 
connected to the Guest PC and applications on the server PC. It also supports audio streaming 
in terminal services sessions. 
The OM Client Virtual Driver must be installed when using the following virtual environments 
 

 Citrix XenApp 
 Remote Desktop Connection (Terminal Service) 

 
The Client Virtual Driver installer can be found in the ODMS R8 Standalone Launcher: 
 

Citrix Client Virtual Driver (32/64bit) \\Citrix_Driver\setup.exe 

Terminal Service Client Virtual Driver(64bit) \\Terminal_Service\x64\setup.exe 

Terminal Service Client Virtual Driver(32bit) \\Terminal_Service\x86\setup.exe 
 

Note: 1. the OM Client Virtual Driver can be installed and used even if the R8 
DM/TM application is installed on the Guest PC. 
2. the version of the client virtual driver used on the Guest PC must be 
the same as the version of ODMS R8 installed on the server PC. 
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2.5 Network connections 
ODMS R8 operating in Citrix, Terminal Service and VMware Horizon support network 
connection over a Local Area Network (LAN), Wide Area Network (WAN) and Virtual Private 
Network (VPN). 
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2.6 Sound Transfer 
In order to play audio on the Guest PC, the sound device (compatible with Windows) on the 
Guest PC must be functioning and correctly configured. 
Therefore, please make sure that the sound device is available and operational on the Guest 
PC. 
 
Since audio playback takes place on the Guest PC, no sound device is required on the server 
PC. More importantly, the Citrix, Terminal Services, and VMware client software must be 
configured to support audio on the client. 
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2.7 Memory and Storage 
In a virtual environment, physical memory/storage is allocated to the virtual environment, so 
settings that exceed physical memory/storage are not possible. 
 
Also, since remote connections consume a large amount of network bandwidth and server 
resources (CPU, physical memory, and storage), please use higher performance models with 
Host PC and Guest PC. 
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3 Using ODMS in the virtual environment 
 
Please refer to the following for instructions on how to build each virtual environment. 
 
 Construction of Windows Terminal Service 

 
 Construction of Citrix XenApp and XenDesktop 
 
 Construction of VMware Horizon 
 
After the virtual environment has been built, setup the ODMS R8 components on the Host PC 
and the Guest PC. Please set up ODMS according to the virtual environment to be constructed 
as follows. 
 
 Configure ODMS on Windows Terminal Service 
 
 Configure ODMS on Citrix XenApp and XenDesktop 
 
 Configure ODMS on VMware Horizon 
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4 Windows Terminal Service 
 
This section describes the supported environment for Terminal Service. 

Before building your environment, please prepare the following in advance. 
 
Preparations 
 
Host PC side： 
 ・Server PC with Windows Server 2016 or later 
 ・Terminal Services License (RDS CAL): Obtained from Microsoft (*1) 
 
Guest PC side: 
 ・Guest PC with Windows 10/11 
 
 
(*1) 
Terminal Services License (CAL) can be used without a license for a grace period (120 days), 
so we recommend purchasing a CAL as soon as possible after construction. 
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4.1 Construction of Terminal Service 
This section describes the steps involved in building a Terminal Service. 
 
 
Procedure 
 

4.1.1 Setup on Host PC side 
 

Step1: Perform Windows Update 
・We recommend that you run Windows Update to keep updated with the latest 
modules. 
 

Step 2: Install the Terminal Services role. 
・Open Server Manager and select Server Roles > Add Role. 
・Select Remote Desktop Service and click Next. 
・On the Select Role Service screen, select Remote Desktop License Manager and 
Remote Desktop Session Host, then click Next. 
・On the Confirm Installation screen, click Install to install. 
 

Step3: Install CAL. 
・Open Remote Desktop License Manager. 
・In Server Manager, select Tools > Remote Desktop Services > Remote Desktop 
License Manager. 
・Select Actions > Import License. 
・Select the license file (.lic) and click Open. 

 
Step4: Remote Desktop Session Host Configuration. 

・In Server Manager, select Tools > Remote Desktop Service > Remote Desktop 
Session Host Configuration. 
・On the Connection tab, set the Allow connections option to Enabled. 
・Set Network Level Authentication to Request. 

 

4.1.2 Setup on Guest PC side 
 
Step1: Perform Windows Update 

・We recommend that you run Windows Update to keep updated with the latest 
modules. 
 

Step2: Open Remote Desktop Connection Client 
・Open the Remote Desktop Connection client. 
・Enter the IP address or hostname of the terminal server to connect. 
・Enter a user name and password, then click Connect. 
 

Step3: Confirmation of remote connection 
・Please confirm that the desktop screen of the server is connected remotely. 
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4.2 Configure ODMS on Terminal Service 
This section describes the steps involved in setting up the ODMS Apps on the established 
Terminal Service environment. 
Before installing ODMS App, make sure that a remote connection is established between the 
Host PC and the Guest PC. 
 
Procedure 
 
Host PC side： 
 ・ODMS R8 Standalone Launcher 
 ・ODMS R8 multi-user License : Get it from your dealer or distributor 
 
Guest PC side: 
 ・ODMS R8 Standalone Launcher 
 

4.2.1 Setup on Host PC side 
 
Install the following ODMS Apps with ODMS R8 Standalone Launcher. 
 
Step 1: Install ODMS R8 

・Install ODMS R8 on the host PC. 
(Enter the ODMS R8 Multi-license you obtained when entering the license key in the 
Setup Wizard to install.) 
 

Step2: Install DCP R8. 
・Multiple devices can be set up via remote connection. 
・Install if administrator wants to set up user's devices. 
 

 

4.2.2 Setup on Guest PCs side 
 
Step 1: Install OM Client Virtual Driver 

Install one of the appropriate Client VDs in ODMS Launcher's Terminal Service folder. 
 
・\Terminal Service\x64 // for 64bit PC 

・\Terminal Service\x86 // for 32bit PC 
 

Step 2: Confirm the connection 
・Open Remote Desktop Connection and start the remote desktop screen of the server 
PC. 
・On the remote desktop, start ODMS R8. 
・Connect the client OM Digital Solutions devices (Voice Recorder, RecMic, Foot 
Switch). 
・Confirm that the devices can be recognized by ODMS R8 at the remote connection. 
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4.2.3 Security Settings 
 
Once you are operating in a virtual environment, review Security for your environment. 
 

4.2.4 Troubleshooting 
 
If you are unable to connect properly, please refer to the Appendix to try to resolve the 
problem. 
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5 Citrix XenApp and XenDesktop 
 
This section describes the supported environments for Citrix XenApp and XenDesktop Server. 
Before building your environment, please prepare the following in advance. 
 
 
Preparations 
 
 
Host PC side： 

・Server PC for Xen Server (Linux based hypervisor) 
・Server PC (Windows Server 2016 or later) for Xen Center (virtual PC management 
within Xen Server) 

  
 ・XenServer Installation ISO CD // Download from Citrix Web site and create CD 
 ・XenCenter Installer(.zip file) // Download from Citrix Web site 
 ・XenApp and XenDesktop Installation (.iso) // Download from Citrix website 
 

・Citrix XenApp and XenDesktop license: Get it from Citrix 
 
Guest PC side: 
 Windows 10/11 PC // For user connection 
 Cirtrix Workspace App or Receiver App // Download from Citrix website 
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5.1 Construction of XenApp and XenDesktop 
 
XenApp and XenDesktop can be built in a variety of ways depending on the size of the system, 
but this section describes the procedure for building a relatively small to medium-sized system. 
 
Procedure 
 

5.1.1 Setup on the Management PC side 
・The appropriate amount of memory and storage space is required according to the 
number of users. 
・Make sure the server PCs for XenServer and XenCenter are connected to the network. 
 
Step1: Perform Windows Update 

・We recommend that you run Windows Update to keep updated with the latest 
modules. 

 
Step 2: Install XenServer on the server PC. 

・Create the downloaded XenServer installation media and follow the instructions to 
install the software. 
・Log in to the XenServer console screen and set the appropriate IP address, host 
name, and login password. 
 

Step3: Install XenCenter on a Windows server PC 
・Run the downloaded Xen Center installer and follow the instructions to install. 
・Log in to XenCenter with your login password. 
・After logging in to XenCenter, register XenServer and Citrix user licenses. 

 
Step4: Set up Citrix Delivery Controller on a Virtual PC  

・Create a new Virtual PC for Delivery Controller and install Windows Server. 
・Extract and run the downloaded iso image of Virtual App and Desktops. 
・At this time, select whether to build with XenApp or XenDesktop and install Citrix 
Delivery Controller. 
 

Step5: Setup of Store Front 
・Install Store Front to store virtual PC desktop and application information. 
 

Step6: Setup of Citrix Studio 
・Install Citrix Studio, a configuration tool for Citrix Delivery Controller. 
・Citrix Studio is a tool for managing and optimizing user access, user authentication, 
license assignment, and session management in virtual desktop and application 
delivery environments. 
 
 

5.1.2 Setup on Virtual Host PCs (Virtual Delivery Agents) side 
 
Citrix VDA is an agent that is installed on a virtual or physical machine; the VDA 
communicates with the Delivery Controller to deliver applications and desktops to users. 
 
Step1: Setup of Citrix Virtual Delivery Agent (hereinafter referred to as VDA) 

・Create a new Virtual PC for Delivery Controller and install Windows Server. 
・Extract the downloaded Virtual App and Desktops iso image, install Citrix VDA, and 
set the Citrix Delivery Controller computer name. 
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5.1.3 Delivery Group settings 
 

Step 1: Setup Citrix Studio 
Delivery Controller and launch Citrix Studio and follow the wizard to set up the 
following items. 
 
・Store Front : Create a public site: Specify a site name. 
・Licensing Settings: Access My Citrix to obtain and set up a Citrix License file (.lic). 
・Create a machine catalog: Specify the VDA PCs, login method, and users to be 
published. 
 

 
Publishing Desktop and Applications 

 
  

Step 1: Within the Citrix Studio select “Delivery Groups” then click “Create Delivery Group” 
to open the setup wizard. 

 

 
 

Step 2. On the Introduction page, click “Next, then for “Machines”, add the appropriate 
number of machines and click Next. 
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Step 3. Regarding users, by default, all domain users are allowed access. 
If you want to limit the number of logged-in users, check the “Restricted user...” checkbox 
and click the “Add” button to add users. 
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Step 4. If you want to set up distribution by Application, click the Add... button on the 
Application screen, 
From Start menu. Select the application you wish to publish from the “From Start menu...”. 
 

 
 

Step 5. For Desktop, click the “Add” button to set the display name of the desktop. Confirm 
that the “Enable desktop” checkbox is enabled. 
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5.1.4 Setup on Guest PCs side 
 

Citrix Workspace App is client software for Guest PCs to access Citrix virtual desktops and 
applications. 
It is a client software for Guest PCs to access Citrix virtual desktops and applications. 
 
Step 1: Download the Citrix Workspace App from the Citrix site. 
Step 2: Install Citrix Workspace App. 
 
The browser will launch and the Citrix login screen will appear. Log in using your user 
account and confirm that the desktop icon list is displayed. 
 
 

5.1.5 Configuring the Citrix Policies  
 

This section describes what Citrix Policies you need to enable to ensure OM Digital 
Solutions devices and audio gets redirected. 
 
Step 1. Within the Citrix Studio select “Policies” then click “Unfiltered” and “Edit Policy...”. 
The setup wizard will then open. 

  
 

Step 2. On the “Setting” page, filter by “USB” and refer to and set the following policy. 
◦ Client USB device optimization rules : User setting 
◦ Client USB device optimization rules : Allowed 
◦ Client USB device redirection rules : User setting 
◦ Client USB Plug and Play device redirection : User Setting 
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When settings are complete, click Next. 

 
Step 3. On the “Summary” page, click “Finish”. 
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5.2 Configure ODMS on Citrix XenApp and XenDesktop 
 
This section describes the procedure for setting up ODMS, assuming that a Citrix virtual 
environment has already been created. 
 
Procedure 
 
Host PC side： 
 ・ODMS R8 Standalone Launcher 
 ・ODMS R8 Multi-License : Get it from your dealer or distributor 
Guest PC side: 
 ・ODMS R8 Standalone Launcher 
 

5.2.1 Setup on Virtual Host PCs side 
 
Install the following ODMS Apps with ODMS R8 Standalone Launcher. 
 
Step 1: Install ODMS R8 

・Install ODMS R8 on the host PC. 
(Enter the ODMS R8 Multi-license you obtained when entering the license key in the 
Setup Wizard to install.) 

 
Step 2: Install DCP R8 

・Multiple devices can be set up via remote connection. 
・Install DCP R8 if the administrator wants to set up user devices. 

 

5.2.2 Setup on Guest PCs side 
 
We will assume that the Citrix Workspace App is already installed on the Guest PC. 
In this section, we will only install the OM Client Virtual Driver for XenApp. 
 

Case of XenApp Case of XenDesktop 

Step 1: Install Citrix Client VD in the Citrix 
folder of ODMS Launcher. 
\Citrix\Setup.exe  

 

Step 2: Once you have restarted GuestPC, log in 

from the Citrix portal site. 

 

NOTE:  
・When Citrix WorkspaceApp is 

updated, Citrix Client VD must also be 
reinstalled. 
 
 

OM Client Virtual Driver is not required. 
 
Connect the OM device and check if the 
device is recognized by ODMS. 
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5.2.3 Publish ODMS as an application 

Normally, you can use ODMS for desktop publishing, but if you want to distribute ODMS as an 

application, select the “Add Application” section in the right pane, “From Start menu...” and 

simply check the “Dictation Module” or “Transcription Module” checkbox. 

 

 
 
When accessing the URL of Store Front with a browser from a Guest PC and logging in, the 
Desktop and Application are available to the public. 
 

Desktop publishing Application publishing 
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5.2.4 Security Settings 
 
Once ODMS starts in the virtual environment, review the Security settings for your 
environment. 
Please change the security settings carefully, as changing the security settings may cause 
symptoms such as no sound, recording, or device not being recognized. 
 

5.2.5 Troubleshooting 
 

If the OM device does not connect properly, please refer to Appendix to try to resolve the 
problem. 
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6 VMware Horizon 
 
This section describes the supported environments for VMware Horizon. 
Before building your environment, please prepare the following in advance. 
 
 
Preparations 
 
 
Host PC side： 
 ・ESXi Server PC (Linux based hypervisor) 
 
 ・ESXi Server installation image (.iso) 

・vCenter Installation image (.iso)  
 ・Horizon Connection Server installer (.exe)  
 ・Horizon Agent installer (.exe)   
 ・Horizon Agent Direct Connection installer (.exe)  // Option 
 

・VMware Horizon user license key 
・VMware vCenter license key 

  
Guest PC side: 
 ・Windows 10/11 PC // for user connection 
 ・VMware Horizon Client // Download from website 
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6.1 Construction of VMware Horizon 
 
 
Procedure 
 

6.1.1 Setup on the Management PC side 
 
・The appropriate amount of memory and storage space is required for the number of 
users. 
・Make sure that the ESXi server PC is connected to the network. 
 
Step 1: Install ESXi on the server PC. 

・Create the downloaded ESXi installation image (.iso) installation media and follow 
the instructions to install. 
・Log in to the ESXi console screen and set the appropriate IP address, host name, and 
login password for your environment. 
 

Step 2: Install vCenter 
・Copy the vCenter iso image to the Storage repository. 
・Open the ESXi IP address in a browser, log in, select the Create VM menu, and 
during the wizard, install vCenter by specifying the vCenter iso image in the Storage 
repository. 
After installing vCenter, set the IP address, host name, and login password according 
to the environment. 
 
・https://{ESXi IP address}:5480 
to access vCenter Management and confirm that the settings are correct. 
Set the IP address, host name, and login password according to your environment 
after installation. 
 

Step 3: Installing Connection Server 
・Copy the Windows Server iso image to the repository. 
・Select “Create VM” menu, and during the wizard, specify the Windows Server iso 
image to set up the server OS. After installation, set the host name and login password 
according to the environment. 
・After setting up, start the Connection Server installer, and in the installation Options, 
check the USB Redirection item. 
 

6.1.2 Setup on Virtual Host PCs (Delivery Agent PCs) side 
 

Step 1: Install the virtual Host PC for distribution 
・Copy the vCenter iso image to the Storage datastore in the management tree. 
・Open the ESXi IP address in a browser, log in, select the Create/Register VM menu in 
the management tree, and during the wizard, install vCenter by specifying the iso 
image copied in the datastore. 
・After installing vCenter, set the IP address, host name, and login password according 
to the environment. 
 

 
Step 2: Launch and install the Horizon Agent installer. 

 
・Copy the Windows 10/11 iso image to the Storage datastore in the management 
tree. 
・Select the Create/Register VM menu in the management tree, and during the wizard, 
specify the iso image copied to the datastore to install the OS. 
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・This setup is repeated according to the number of virtual PCs built. 
Please take a snapshot of your virtual PCs and back them up. 
 
・Horizon Agent Direct Connection installer enables remote connection to virtual PCs 
without Connection Server. It is optional and should be installed as needed. 
 

 

6.1.3 Delivery Settings  
 

Step1: Configuring the Horizon Console 
Log in to the Connection Server and launch the Horizon Administrator Console in a 
browser. 
 
https://{server_ip}/admin 
・Server Certificate Settings 
・vCenter Server Server Registration 
・User authentication 
・Registration of Virtual Host PC 
 

 

6.1.4 Setup on Guest PCs side 
 
Install VMware Horizon Client on the Guest PC side. 
 
Step 1: Install XenServer on the server PC. 

・Run the downloaded VMware Horizon Client installer, follow the wizard instructions, 
and reboot the PC. 

 
Step 2: Start VMware Horizon Client 

・Start VMware Horizon Client and add the IP address of the Connection Server with Add. 

・After logging in to the server, the Delivery Group will be displayed, and confirm that the 

registered Virtual PC is displayed and started. 
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6.2 Configure ODMS on VMware Horizon 
 
In this section, please follow the steps below to set up ODMS Apps on the Citrix environment 
you have built. 
Before installing ODMS, make sure that a remote connection is established between the Host 
PC and the Guest PC. 
 
Procedure 
 
Host PC side： 
 ・ODMS R8 Standalone Launcher 
 ・ODMS R8 Multi-License : Get it from your dealer or distributor 
 
Guest PC side: 
 ・ODMS R8 Standalone Launcher 
 

6.2.1 Setup on Host PCs side 
 
Log in to the virtual Host PC for distribution and install the following ODMS Apps with 
ODMS R8 Standalone Launcher. 
 
Step 1: Installation of ODMS R8 

・Install ODMS R8 on the Host PC. 
(When entering the license key in the Setup Wizard, enter the ODMS R8 Multi-license 
that you have obtained to install the software.) 
 

Step 2: Install DCP R8 
・Multiple devices can be set up via remote connection. 
・Install if the administrator wants to set up user devices. 

 
 

6.2.2 Setup on Guest PCs side 
 
For VMware Horizon, the OM Client Virtual Driver is not required. 
 
・Launch VMware Horizon Client and login. 
・After logging in, the desktop or application to be published will appear on your site, 
make sure it is up and running. 
 

 

6.2.3 Security Settings 
 
Once ODMS starts in the virtual environment, review the Security settings for your 
environment. 
Please change the security settings carefully, as changing the security settings may cause 
symptoms such as no sound, recording, or device not being recognized. 
 

 
 

6.2.4 Troubleshooting 
 

If the OM device does not connect properly, please refer to Appendix to try to resolve the 
problem. 
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7 Appendix 
 
 

7.1 Security Settings 
 
A virtual environment consists of multiple servers, Host PCs, and Guest PCs, and therefore 
has different security risks than a normal environment. 
Please make sure to properly configure the necessary security settings on each PC. 
 
Below are the key points for security settings. 
 
1. Security enhancement of Management PC and Virtual Host PC 

・Perform Windows Update and apply the latest OS and patches. 
・Consider strong passwords and authentication methods for user accounts. Consider 
strong passwords and authentication methods for user accounts, such as multi-factor 
authentication (MFA). 
・Use firewall settings and Intrusion Detection Systems (IDS): Use a firewall to block 
unauthorized access and an IDS to detect intrusions. 
・Perform regular backups: Create regular backups of the host system and all VMs and 
store them offsite. 
・Encrypt virtual disks: Encrypt virtual disks to prevent data leakage. 
・Monitor network traffic: Monitor network traffic between virtual machines to detect 
malicious activity.  

 
2. Security enhancement through policy settings for virtual environments 

・Policy settings (GPOs) for each virtual environment, if provided, can be added to 
further enhance security. 
 
・Limit the number of devices recognized: Limit the number of devices recognized, 
especially those recognized as storage. 
・Restrict unnecessary user operations: Grant only the minimum privileges necessary 
to perform required tasks. 
・Appropriately configure firewall settings, port settings, etc., depending on the 
environment. 
 

 
・Please take other security measures as necessary. 
・Please refer to the manufacturer's website for connection problems. 
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7.2 Troubleshooting for virtual environments 
 
Below are the Troubleshooting sites of each virtual environment manufacturer. 
 

Terminal Service Remote Desktop Services Troubleshooting 

 

Citrix XenApp and XenDesktop https://docs.citrix.com/en-us/citrix-virtual-apps-
desktops/2402-ltsr/technical-overview.html 
 

VMware Horizon https://techzone.omnissa.com/resource/understand-and-
troubleshoot-horizon-connections#understanding-horizon-
connections 
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7.3 Troubleshooting for ODMS using virtual environments 

7.3.1 Common 

No. Summary Detail 

1 
Can not use voice 
recognition functions. 

On all virtual environments, you cannot use the voice recognition 
functions. 
This is because Nuance Dragon speech recognition software does not 
support virtual environments. 

2 
When playing an audio file, 
a choppy sound is played.  

In virtual environment, when the transfer rate is high, sometimes a 
choppy sound may be played. 
In this case, please hide the level meter indicator in the Option 
setting dialog when it is displayed in Direct Recording Window or 
Playback Control. 
 

3 

When using RecMic 
connected to PC, the 
response of operation 
(button or slider) is slowly. 
 

By environment, this issue occurs that virtual PC is not update to 
latest condition. 
Please apply service packs and patches and update the virtual PC to 
latest version. 

 

7.3.2 For both Citrix XenApp/Terminal Service session 

No
. 

Summary Detail 

1 
Can not playback/control 
sounds on DVRs 

On both Citrix XenApp/Terminal Service session, there are some 
limitations on playing back and editing sounds on DVRs below. 
- Can not playback sound on DVRs 
- Can not edit sounds, includes insert/delete index marks, edit job 

data, Edit Dictation, Change Status, change priority, etc. 
 

2 
Can not upload sounds 
 into DVRs 

On both Citrix XenApp/Terminal Service session, you cannot upload 
any sound files into DVRs connected to Guest PC. Of course, you can 
download sounds from DVRs. 
 

3 
When playing audio file on 
client side, choppy audio 
was played. 

On both Citrix XenApp/Terminal Service session, audio data and 
screen information is transferred via specific transfer protocol. 
When a network bandwidth is low, there is a case which the issue 
occurs. 
In this case, If set to hide the level meter in “Playback Control”, it 
will improved. 
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7.3.3 For Citrix XenApp session 

No. Summary Detail 

1 Noise on sound 
When using Citrix XenApp, playback may be interrupted periodically.  
For solutions, please refer to the Citrix Presentation Server/Client 
manuals. 

 

7.3.4 For Citrix XenApp/Desktop session 

No. Summary Detail 

1 

WMA file is not supported 

on Citrix 

XenApp/XenDesktop. 
 

Before versions of XenApp/Desktop, wma file is not built-in support. 
However, in some previous versions, Hotfix program was released as 
can playback wma files. 
  
Since it takes a long time to support this, we decide this behavior is 
a limitation. 

 

7.3.5 For Terminal Service session 

No. Summary Detail 

1 Playback volume control 

ODMS R8, control playback volume without using Microsoft RDP 
Audio Driver. Playback volume is controlled via volume control and 
wave control of client playback mixer device using volume slider of 
DM/TM. Therefore, you have to set the client playback mixer device 
to appropriate volume. 
 

2 Playback of stereo sound file 
Stereo sound files are played as mono sound to eliminate or reduce 
CPU overload 
 

3 
Operating in Workgroup 
type network 
(no Domain) 

To operate the ODMS R8 in virtual environment in a Workgroup 
network, the Guest account must be enabled and the “Simple file 
sharing” activated. 
To activate Simple file sharing, open “My Computer” (or Windows 
Explorer window). From the menu, select [Tools] -> [Folder 
Options…] to open the Folder Options window. 
From the Folder Options window, select the [View] tab and from the 
“Advanced settings” list, select the box “Use simple file sharing 
(Recommended)” and then click OK. 
To enable Guest account, check the Users group on the PC and make 
sure the Guest account is enabled (Disabled is unchecked). 
 

 

7.3.6 For VMware connection 

No. Summary Detail 

1 
A restriction of 
Communication Type 
 

If the communication protocol is not set to VMware Blust or PCoIP, 
ODMS R8 will not recognize any HID devices. 
In your login screen, please confirm that the communication protocol 
is set to "VMware Blust”. 
 

2 

Cannot change the speaker 
setting on VMware horizon 
view. 
 

In VMware Horizon, when you try to change speaker setting on 
ODMS, it cannot change the speaker setting by ODMS, and Only 
VMware Horizon can change the speaker setting itself. 
No sound output from ODMS when changing to different speakers 
from VMware Horizon. 
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7.4 FAQ 

7.4.1 For both Citrix/Terminal session 

No. Summary Detail 
1. Sound Issues 

1 No sounds on “Edit Job Data” 
dialog 

When you use DM/TM on Citrix/TS session, you cannot use the 
preview function on “Edit Job Data” dialog during downloading 
from DVRs. This is a restriction of ODMS R8. you cannot playback 
any sounds on the DVRs. In this case, the sound file is still on the 
DVR connected to the Guest PC. 
Therefore, you cannot review it. 

2 Can not change Speaker/Mic 
device from DM/TM 

You cannot change speaker and microphone device from the 
DM/TM's menus. This is a limitation of the Windows OS. To solve 
this problem, you will need to set the speaker/microphone device 
as the default device on the system. Please open "Sound" property 
dialog from "Setting" and configure it as the default. 
 
the OS does not permit this operation. Therefore, you will need to 
set it manually. 

3 Can not playback any sounds 
and its playback time is shown 
as “00:00:00” on the indicator 

The sound filters have not been registered correctly. Please 
reinstall both the DM/TM and the OM Client Virtual Driver. 
If you use Windows Server, Windows Media Player may not have 
been installed. Please re-install WMP and try again. 
 

2. On Logging in to the remote session 

1 DD6 does not start 
The Client Virtual Driver may not be loaded correctly. Log off the 
remote session, reinstall the Client Virtual Driver. Then, try again. 

2 A runtime error happens in 
DD6 

If you connect multiple devices to the PC, such as recorders and 
RecMic devices, please disconnect all of them and login again. 

3. On starting softwares up 

1 
DM or TM does not start 
(without the splash window) 

- DM or TM does not work when other OM Digital Solutions Audio 
software, such as “DSSPlayer Standard” are opened. Please close 
them and try again. 
- An old process may still have been left running. Log off the 
remote session, login, then try again. 

2 
An error message appears on 
starting up 

1. “The device detection and play/record functions for audio 
files are not available because the driver for Citrix/Terminal 
Service is not installed on the Guest PC” 

The OM Client Virtual Driver may not be loaded correctly. Log off 
the remote session, and reinstall the OM Client Virtual Driver. 
Then, try again. 

2. “The dictation cannot be played. The audio device needed 
to play the dictation cannot be found.” 

DM/TM cannot find any available audio devices on the Guest PC. 
Please confirm the audio device driver is available and works 
fine on your Guest PC. 
 

4. On connecting devices 

1 Does not recognize any 
devices The OM Client Virtual Driver may not be loaded correctly. Log off 

the remote session, and re-install the OM Client Virtual Driver. 
Then, try again. 2 

Cannot see any files on the 
DVRs 
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7.4.2 For Citrix session 

No. Summary Detail 

1 
Can not install Citrix Client 
Virtual Driver 

No Citrix client software has been installed. 
When you install a Citrix Workspace App by a limited user, please 
re-install it with administrator permission. 
After that, please install our OM Client Virtual Driver. 
 

2 
Cannot playback an WMA 
format 

In case under Citrix environment, WMA files cannot be played 
back. When you encounter such a situation. 
 

3 

Cannot recognize any OM 
Digital Solutions device of 
Storage Mode auto matically 
in XenDesktop connection 
 

It is possible that auto-detection of USB flash drives is disabled in 
Citrix Workspace App for Windows, please try the following 
 
Device will be recognized with auto-detect, by setting following 
registry keys on Guest PC.  
HKLM¥SOFTWARE¥Citrix¥ICA Client¥GenericUSB¥Devices 
"AutoRedirectStorage"=dword:00000001 
0: Disables auto-redirection  
1: Enables auto-redirection  
 
In addition, when exist in the following registry key, this value is 
used with precedence. 
HKLM¥SOFTWARE¥Policies¥Citrix¥ICA Client¥GenericUSB¥Devices 
"AutoRedirectStorage"=dword:00000001 
 

4 

Cannot recognize any OM 
Digital Solutions device of 
Composite Mode in 
XenDesktop connection 
 

In XenDesktop environment, when connect a device of Composite 
Mode, “Other applications may use the device.” message will be 
displayed. 
In this case, please try the following 
 
Case of 32bit OS: 
HKLM¥SOFTWARE¥Citrix¥ICA Client¥GenericUSB 
"EnableForceRestartForHID"=dword:00000001 
 
Case of 64bit OS: 
HKLM¥SOFTWARE¥Wow6432Node¥Citrix¥PortICA¥GenericUSB  
"EnableForceRestartForHID"=dword:00000001 
 

5 

OM Digital Solutions devices 
not recognising in ODMS but 
appears redirected in 
XenDesktop 

This only affects mobile recorders that are set to storage mode and 
RecMics. 
 
Please do either or all of the following:  
 
Go to Devices under Citrix Preferences ensure the devices are not 
set to optimised redirection and switch to generic redirection in the 
virtual channel. 
 
Set the mobile recorder to composite mode and this will recognize 
automatically in generic mode. 
 
Set the following registry key and this will recognise the RecMic 
automatically in generic mode.  
HKLM¥SOFTWARE¥Citrix¥ICA Client¥GenericUSB¥Devices 
    "AutoRedirectAudio"=dword:00000001 
 

6 

How to configure RecMic 

devices to be redirected on 

XenDesktop automatically.  

To recognize the RecMic devices to XenDesktop automatically, the 

following registry setting is needed. 

  

  HKLM¥SOFTWARE¥Citrix¥ICA Client¥GenericUSB¥Devices 
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    "AutoRedirectAudio"=dword:00000001 

 

7 
Foot control not recognising in 

ODMS within XenApp  

In XenApp environments using Citrix Workspace App, in rare cases 

the foot controller may be redirected to a Citrix session and the 

foot controller will not be recognized within the ODMS software. 

 

Please try the following: 

1. Go to Devices under Citrix Preferences and untick redirect 

devices to session.  

2. Set a USB redirection rule and deny the foot control from 

redirecting to the citrix session. 

 

The citrix client drivers will handle the device connection to the 

session therefore USB redirection is not needed for devices in a 

XenApp environment. 

 

8 

Unable to perform recording 

in Direct Recording Window in 

XenApp Storage mode 

If ODMS does not have a microphone device capable of recording, 
the Record button is disabled and recording cannot be performed. 
However, if a DVR with a Storage Mode that can be changed to 
Composite Mode is connected, recording can be performed. 
 
On the other hand, recording in the XenApp environment is 
performed using the microphone (treated as a PC microphone) 
specified as the "specified device" on the Guest PC. 
 
In the XenApp environment, recording is performed until the DVR 
in Storage Mode is switched to Composite Mode as in the Local 
operation described above, but when it is switched to Composite 
Mode, the association between the DVR and the microphone device 
is not properly performed, so even if the switch is made to DRW 
Recording itself cannot be performed. This is a limitation of the 
XenApp environment, but we have added a condition to determine 
whether or not recording is possible in the XenApp environment, 
 
Even if there is no microphone device that can record, but a 
Storage Mode DVR is connected, recording is set to not be possible 
in the XenApp environment. 
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7.4.3 For Terminal Service session 

No. Summary Detail 

1 Can not playback any sound 

 
Failed to register sound filters in the installation of TS Client VD(1) 
Our TS Client VD intermediates sounds between the Server and the 
Guest PC. When the installation of TS Client VD fails, some sound 
filters aren't registered correctly to the Guest PC and you can't 
hear any sound on the Guest PC in this situation. Please check that 
you installed our client VD using Administrative permission and try 
reinstallation. Sometimes this will solve this problem. 
(This solution is applied only to TS. On Citrix session, Client VD 
does not intermediate any sounds.) 
 
Failed to register sound filters in the installation of TS Client VD(2) 
If you install TS Client VD using administrative permission, check 
your registry on the Guest PC. If you cannot find the keys below in 
your registry, sound filters may not have been installed on the 
Guest PC. 
 
{379D73EE-F1EE-4edd-A8D0-FF95C9A80F85} 
{9F1642AE-1C3B-4400-9AA4-AD140A44E836} 
 
If you encountered this situation, please contact OM Digital 
Solutions dealer. 
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7.4.4 For VMware connection 

No. Summary Detail 

1 Cannot recognize a HID 
device. 

Configure USB device filters and redirecting Human Interface Devices 
(HIDs) in View Client 
 
For more detail, please refer the following VMware web site. 
 

2 

Mouse pointer does not 
track the movement of a 
HID device. 
 

Mouse pointer does not track the movement of a redirected USB 
human interface Device 
 
For more detail, please refer the following VMware web site. 
 

3 
 

How to make sure which 
models VMware Horizon is 
supported.  

It this can be found in VMware website. 
 

4 

Cannot recognize any 
device of Composite 
Mode. 
 

In VMware environment, when you connect a device in Composite 
Mode, “Other applications may use the device.” message will be 
displayed. 
In this case, you will need to set the following registry key.  
 
This issue occurs when OM Digital Solution DVRs or RecMic is 
connected to Guest PC set as DefaultAudioDevice and Device Handler 
is opened by Windows Audio Device Service. 
We have already requested a solution to this from VMware corp.  
 

5 
Poor playback audio 
quality 

In VMware environment you may experience poor playback audio 
quality such as audio being distorted, stuttering, or dropping out.  
 
Please visit the VMware website link below for workarounds on 
improving the audio playback quality.    
 

 
 


